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Chapter 1 • Introduction 

Description 
The Dolphin 7500 Terminal is a ruggedized PC with a powerful AMD 5x86 processor 
supporting MS-DOS 6.22. The computer is equipped with 4MB RAM and 8MB flash. 

The terminal’s large display is easy to read. High-contrast and visibility of both the 
standard electroluminescent display and the optional color display provides for many 
viewing angles. The terminal also offers touchscreen input for menu-driven applications. 

The rugged aluminum enclosure is suited for harsh work environments. An optional 
version with a sealed case is available to operate in a wider range of temperature and 
humidity levels and withstand greater shock and vibration levels. 

To allow network expansion as needed, the 7500 terminal works with all 2.4 GHz WLIF-
compliant products. The terminal can be connected to other devices, such as printers and 
PC’s via PC-card adapters. The 7500 can also be connected to a network with a 2.4 GHz 
wireless LAN or hardwire with Ethernet. It also supports terminal emulation. 

For more information, contact www.handheld.com.   

Picture 
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Introduction 

Setup Requirements 
Installation of PowerNet Twin Client requires, at a minimum, the following: 
• A Pentium-class processor 
• 32 MB of RAM 
• 10 MB of free hard disk space available 
• Microsoft Windows 95, 98, ME, XP, or NT/2000 
 

Accessories 
The following accessories are available with the 7500 terminal: 
 

• 2.4 WLIF PC Card Radio - PC radio card for Dolphin 7500 with 
preprogrammed country code 

• AC Power Supply for Desk Mount - 4 amp, 100 - 240 volts 
• External DC/DC Power Supply - 12 volt and 24 - 48 volt versions available 
• Industrial Keyboard - Keyboard with locking connector and mounting bracket 
• Universal Fork Truck Mount - Mounting bracket for Dolphin 7500 
 

Bios 
Version of BIOS 
The version of BIOS on a 7500 terminal is 1.01.28. 

Finding the Version of BIOS 
The version of BIOS will appear on a terminal screen when the terminal is rebooted.   
For rebooting instructions, see Cold Booting the Terminal in the Configuring the 
Terminal for Download section. 
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Chapter 2 • Terminal Setup 

Downloading from the WEB 
The PowerNet Twin Client software package can be downloaded from the Connect web 
site at http://www.connectrf.com. Click on Partner Services and then click on Software 
Downloads. Select the file named PowerNet Twin Client for Hand Held Products. 

Running Setup from a Download File 
The downloaded file is a compressed archive. After extraction using a utility such as 
WinZip or PKWARE, folders are created on the hard disk as shown in the following 
figure. 

 

Click on the Disk1 folder to view the files as shown in the following figure. 

 

Click on the Setup application and proceed to the following section entitled Installation 
for further instructions. 
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Terminal Setup 

Installation 
The InstallShield wizard runs and presents the following screen. 

 
Click on Next to begin the installation process. 

 
To change the default Destination Location, click on Browse and select a location. Then 
click on Next. 
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The default folder is PowerNet. This default may be changed either by selecting an 
existing program group or by typing in a new name at the prompt. Then click on Next. 

 
When the installation is complete, reboot the system to initialize the Twin Client 
software. 

a. To reboot the system immediately, click on Finish. 

b. To reboot later, click on the option to restart the computer later, and click on Finish. 

 

 

 

Supported Equipment Manual   •    March, 2006  2-3  



Terminal Setup 

Running the Manager 
The PowerNet Twin Client Manager is the utility that manages the terminal software and 
configurations. 

Select Start, Programs, PowerNet, and Twin Client Manager.  The PowerNet Twin 
Client Manager screen appears as shown in the following figure. This is the 
administrator's main screen, and all functions are accessed from its menu bar, toolbar, and 
tabs. 

Menu Bar 
The menu bar provides access to the functions used to configure the terminals and 
manage their software.  

 

Toolbar 
Found under the menu bar, the toolbar provides shortcuts to major features. The toolbar 
can be turned on or off by changing the Toolbar parameter found on the View menu. The 
shortcuts available from the toolbar are as follows:  

 Create a new terminal configuration. 

 Open an existing terminal configuration. 

 Save the current terminal configuration. 

 Download the configuration to the terminal. 

 Download software to the terminal. 

 Configure terminals automatically over the wireless network. 

 View the PowerNet Twin Client Manager version. 

The PowerNet Twin Client Manager is now successfully installed and ready for use.  
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Quick Start 
This section describes how to prepare the Twin Client Manager and the Hand Held 
Products terminal for a Telnet session with the host. Following an initial serial download, 
the terminal software and configuration are managed automatically over the wireless 
network. 

Note: Hand Held Products terminals are normally delivered with Hand Held Products 
files pre-installed. However, if the terminal does not have those files installed, 
refer to Manual Download of Configuration Files before proceeding. 

Configuring the Manager 
The first step is to configure the Twin Client Manager to meet site-specific requirements, 
and then prepare it for the automatic management of the terminal software and IP 
addresses. This simple procedure will require only a few minutes to complete. 

Setting the Emulation 

Click on Start, Programs, PowerNet, and Twin Client Manager. Select the Settings 
menu. 
 

 

Click on Emulation, select the desired emulation, and click on OK. 

 

Setting the Servers 

The Servers are the Telnet host systems the terminals will access. 
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To set these addresses from the Settings menu, click on Servers and then click on Add. 
Enter the name of each server, its IP address and IP port (normally 23 for Telnet servers), 
and emulation type. Then click on OK. 

 

Repeat this step for each Telnet server the terminals are required to access. If an error is 
made in the name, IP address, IP port number, or terminal emulation type, click on the 
line that is in error and then click on the Edit button to make the corrections. Use the 
Load button if you want to load an .svr file. Use the Save As button if you want to save 
your file as an .svr file. 

Setting Terminal Operations 
 
Select Terminal Operation from under Settings in Twin Client Manager. 

  

 

The option of Run Airloader on terminal can be selected.   
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Click on OK after entering information. 

Setting Terminal Model and COM Port 

To select a specific Hand Held Products terminal model, radio type, or COM port 
assignment, click on the Options menu as shown. 
 

 

To maintain compatibility with existing Hand Held Products Telnet client keyboard 
layouts, a specific terminal model must be selected from the Terminal Model window. 

Supported Equipment Manual   •    March, 2006  2-7  



Terminal Setup 

 
 

Saving the Configuration 

Click on File and Save As. Enter a name for this configuration. 
 

 

For the purposes of this example, the name is vt220. 
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Setting Airloader Auto-Configuration 

The configuration download and IP address assignment for each terminal will take place 
automatically by setting the Airloader Auto-Configuration options. 
 

 

Click on the Airloader option in the Tools menu. 

Note: If the Airloader Auto-Configuration window does not display the options, click on 
the Advanced<< button. 

If multiple network adapters are installed on the PC, ensure that the desired network 
adapter is selected. The adapter selection can be changed by clicking on the Change 
button. 
 

 

This powerful software management tool is described in detail in Airloader Auto-
Configuration. For now, it is sufficient simply to use it for assignment of the initial 
terminal configuration and IP address, both of which can be easily changed later. Ensure 
that all of the check boxes are checked as shown above. 

To assign terminal IP addresses automatically over the wireless network, check all of the 
boxes as shown above. Then click on the Addresses button and enter the desired range 
in the From and To boxes as shown in the following figure. 
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After setting the address range, click on OK to return to the Airloader Auto-Configuration 
screen and then click on the box next to Terminal/Group Manager. 
 

 

The display expands to show the default terminal group. Next, click on the New Group 
icon and use the Browse button to select the configuration file saved earlier. 
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Check the Active box, and the system is now configured to automatically download IP 
addresses, software, and configuration files to the terminals. Click on the  box in the 
upper right corner to return to the main menu. 

Note: The software does not need to be authorized now. It can be authorized later, after a 
Telnet session has been established. The procedure is described in Authorizing 
PowerNet. 
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Configuring the Terminal for Download 
 
The terminal is ready for the download of files after a cold boot. 
 
To cold boot the terminal (following power OFF), exit to the DOS prompt from main 
screen by pressing <shift> to view uppercase mode, pressing <C> for the Edit Functions 
screen, pressing <F2> to Exit, and pressing <enter>.  Then, press the <shift> <bksp> 
and <on scan> keys simultaneously, and release. 

Troubleshooting 

The following table describes the error messages that will be displayed on the terminal in 
the event of a download failure, and can be used as a guide to correcting the problem. 

 
Error Indication Possible Cause Corrective Action 
NOT Associated Invalid Security ID Run RFSETUP, set Security ID 

to match access point. See 
Chapter 4 for instructions. 

Unable to open 
connection 

IP stack on terminal 
failed to load. 

Reload Hand Held Products 
driver files. 

Timeout waiting 
for data 

Transient 
communications 
failure 

Reboot terminal. If problem 
persists, check the RFSYNC.log 
in the PowerNetTN directory. 

Download aborted Socket closed during 
download 

Ensure PC is operating. Reboot 
terminal and retry. 

Manager inactive PC not operating Restart the PC. 

After taking the corrective action, the terminal must be cold booted.   

A successful wireless connection and download is indicated by the display of the Twin 
Client main menu shown below. 
 

Twin Client 
© 1991-2006, Connect, Inc. 
 
Keypress to Continue  

Note: The date of 2006 is updated on the terminal at the time of a new release. 

The terminal is now ready to establish a Telnet session with the host system. 
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Standard Setup 
The default terminal setup is sufficient for most installations. However, to meet site-
specific requirements, it may be necessary to customize terminal operation. The standard 
setup options simplify this process and can be modified by the following methods: 
• Using the Twin Client Manager. 
• Using the Twin Client terminal menu system. 

This section describes how to use the Twin Client Manager and the terminal menu 
systems to set up the terminal. Also described are the methods for authorizing the 
terminal software. 

Setup Using Twin Client Manager 
The Twin Client Manager provides a Standard Settings tab for automatic setup of the 
terminals. Click on Standard under the View menu. The options within this tab vary 
according to the emulation selected, each of which is described below. 

VT Settings 

Select the VT emulation setup by clicking on the Settings menu and then the Emulation 
menu. 

 

Then click on the VT100 or VT220 selection. 

 

Click on OK after the selection is made, and return to the main Twin Client Manager 
menu. The standard settings tab will now reflect the settings for VT emulation. 
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Quadrant Mode 

This scrolling list option defines the rules by which the terminal display is positioned in 
the larger host display. As defined by Twin Client, quadrants are fixed position 
"windows" in the host display, and the terminal display is located on whatever quadrant 
contains the current cursor position. 

Off disables quadrant processing and Twin Client simply centers the current host 
input field in the terminal display.  

 On enables quadrant processing. However, input fields that cross quadrant 
boundaries result in a shift to the left in order to locate as much of the current input 
field on the terminal display.  

 Soft always positions on a quadrant boundary regardless of input field boundaries. 
Viewing keys are enabled. 

 Hard is the same as Soft except the viewing keys are disabled.  

Lock locks the terminal display origin (upper left corner) to fixed row and column 
(x,y) coordinates in the host display. The coordinates are zero-based.   
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Font Size 

These check boxes enable (checked) or disable (unchecked) the display of characters in 
double high and double wide font. 

Key Click 

This check box enables (checked) or disables (unchecked) audible key clicks from the 
terminal, provided that the manufacturer supports the control of terminal key click sound. 
The default value is on (checked). 

Printer Type 
 

This scrolling list selects the attached printer type. The default value is none, indicating 
that no printer is attached. 

5250 Settings 

Select the 5250 emulation setup by clicking on the Settings menu and then the 
Emulation menu. 

 

Then click on the 5250 selection. 

 

Click on OK after the selection is made, and return to the main Twin Client Manager 
menu. The standard settings tab will now reflect the settings for 5250 emulation. 
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Quadrant Mode 

This scrolling list option defines the rules by which the terminal display is positioned in 
the larger host display. As defined by Twin Client, quadrants are fixed position 
"windows" in the host display, and the terminal display is located on whatever quadrant 
contains the current cursor position. 

Off disables quadrant processing and Twin Client simply centers the current host 
input field in the terminal display.  

 On enables quadrant processing. However, input fields that cross quadrant 
boundaries result in a shift to the left in order to locate as much of the current input 
field on the terminal display.  

 Soft always positions on a quadrant boundary regardless of input field boundaries. 
Viewing keys are enabled. 

 Hard is the same as Soft except the viewing keys are disabled.  

Lock locks the terminal display origin (upper left corner) to fixed row and column 
(x,y) coordinates in the host display. The coordinates are zero-based.   

Font Size 
 

These check boxes enable (checked) or disable (unchecked) the display of characters in 
double high and double wide font. 
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Key Click 

This check box enables (checked) or disables (unchecked) audible key clicks from the 
terminal, provided that the manufacturer supports the control of terminal key click sound. 
The default value is on (checked). 

Printer Type 

This scrolling list selects the attached printer type. The default value is none, indicating 
that no printer is attached. 

3270 Settings 

Select the 3270 emulation setup by clicking on the Settings menu and then the 
Emulation menu. 

 

Then click on the 3270 selection. 

 

Click on OK after the selection is made, and return to the main Twin Client Manager 
menu. The standard settings tab will now reflect the settings for 3270 emulation. 
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Quadrant Mode 
 
This scrolling list option defines the rules by which the terminal display is positioned in 
the larger host display. As defined by Twin Client, quadrants are fixed position 
"windows" in the host display, and the terminal display is located on whatever quadrant 
contains the current cursor position. 

Off disables quadrant processing and Twin Client simply centers the current host 
input field in the terminal display.  

 On enables quadrant processing. However, input fields that cross quadrant 
boundaries result in a shift to the left in order to locate as much of the current input 
field on the terminal display.  

 Soft always positions on a quadrant boundary regardless of input field boundaries. 
Viewing keys are enabled. 

 Hard is the same as Soft except the viewing keys are disabled.  

Lock locks the terminal display origin (upper left corner) to fixed row and column 
(x,y) coordinates in the host display. The coordinates are zero-based.   

Double High and Double Wide Font 

These check boxes enable (checked) or disable (unchecked) the display of characters in 
the double-high and double-wide fonts. 
Key Click 

This check box enables (checked) or disables (unchecked) audible key clicks from the 
terminal, provided that the manufacturer supports the control of terminal key click sound. 
The default value is on (checked). 
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Printer Type 

This scrolling list selects the attached printer type. The default value is none, indicating 
that no printer is attached. 

Terminal Setup Using Twin Client Menus 
The Twin Client terminal software provides an internal menu system for configuring 
certain parameters on the terminal and for switching between Server and Telnet modes of 
operation.  To access this menu system, press uppercase C at the startup screen below. 
 
Twin Client 
© 1991-2006, Connect, Inc. 
 
Keypress to Continue 

The following menu appears. 
 
Edit Menu Options 
Edit Mobile Unit IP 
Edit Server/Host IPs 
Edit Radio Option 
Edit License Key  
Run Site Survey 
Switch Client Modes 
Run Client Emulator 
Exit to OS 

Use the Up-Arrow and Down-Arrow keys to navigate the menu, and press Enter to select 
the highlighted option. Each menu option is described below. 

Edit Mobile Unit IP 

The IP list contains the terminal IP address, the Subnet Mask and the Router IP address. 
Enter the appropriate address and select <F3> to save and/or <F7> to Quit. 

 

 

Edit Server/Host IPs 

IP  206.232.71.38 
SN  255.255.255.0 
RT  206.232.71.1 
 
<F3> Save  <F7> Quit 

If the host IP address(es) were not pre-configured as described in the Setting the Servers 
section of Configuring the Manager, or if you wish to change those settings using the 
terminal menus, select this option and enter up to four Host IP addresses as required. 
 

Host 0 
IP 206.183.67.155 
Port 23__ 
 
<F3> Save <F7> Quit 

Press <F3> to save the configurations. 
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Edit Radio Option 

This function acts as a password to join the radio network.  Terminals associating with an 
Access Point must supply a matching value, determined by their configurations, or their 
association requests will be ignored. 
 

ID  tsunami____________ 
 
<F3> Save    <F7> Quit

Edit License Key 

The client software can be authorized automatically. This menu option permits 
authorization of each terminal manually. Select this option to obtain the terminal's 
Identification Code, used to obtain the Authorization code from Connect’s web site. 

The 12-digits displayed at the terminal screen top is the terminal’s Identification Code. 
 

00A0F826E614 
Authorization 
______________ 
not authorized 
 
<F3> Save <F7> Quit 

Type the authorization code into the field as it appears on the web site. Punctuation 
characters, such as the hyphen (-), are required. Press <F3> to save the auth code. 

Run Site Survey 

This option is applicable to Release 5.0 and may be obsolete for your terminal. 

Switch Client Modes 

The PowerNet Twin Client normally operates in Telnet mode, which provides direct 
connection to Telnet hosts. It can also operate in Server mode, through a PowerNet 
OpenAir server. Select this menu option to switch between Server and Telnet modes of 
operation. Note that the host socket address for the PowerNet OpenAir servers is 1800, 
which must also be changed in the Edit Server/Host IPs menu described above. 

Run Client Emulator 

After all desired changes have been made, select this option to return to the Twin Client 
main menu. Then press any key to establish the Telnet session and begin emulation.  
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Authorizing PowerNet 
 
Each PowerNet Twin Client will run for 30 minutes at a time without authorization.  
Uninterrupted operation for a production environment is the result of authorizing the 
software.  

The Twin Client Manager can automatically authorize the terminal over the wireless 
network if the following requirements are met: 
• A PC running Twin Client Manager is connected to the wire LAN segment with at 

least one access point within range of the terminal. 
• The System ID of the PC on which Twin Client Manager is installed has been used to 

obtain a site license Authorization code from the Connect web site. 

To obtain the Twin Client Manager’s System ID, click on Authorization under Tools. 
 

 

The Authorization window is displayed as shown below. 
 
 

 
 

 
Your System ID appears in the first box of the screen.  
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Go to http://www.connectrf.com. Click on Partner Services. Click on the Generate 
Authorization icon at the top of the page. Follow the directions on the web site. 

Authorized Terminals 

The number of terminals authorized, the number of terminals in use, and the number of 
terminals remaining is provided in the Authorized Terminals box on the lower left side of 
the screen. 

Click on the Details button to number the options in the screen below in the order of your 
priority. 

Note: The terminal may or may not be able to utilize the Formatter feature depending on 
its authorization codes. 

 

Click on an option and move it using the Up and Down buttons.  

Click on OK when finished. 

The Manual Authorization button is an alternate method of obtaining an authorization 
code for a terminal. This method does not utilize Airloader, as does the other method. 
 
Click on this button, manually enter your mac address in the screen that appears, and 
click on OK. This enables you to generate individual authorization codes. 
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Add Licenses 
The Add Licenses feature is used when adding additional licenses to an already site 
licensed Twin Client Manager. (i.e. Twin Client Manager is licensed for 10, and the 
customer purchases another 10 licenses to make a total of 20.)   

From Twin Client Manager, choose Authorization from under the Tools menu. Click on 
the Add Licenses button.  

 

A pop-up box appears with the machine ID and a space for the additional license’s 
authorization code.  Enter the additional license’s authorization code and click on OK. 

Use the machine ID in the pop-up box instead of the original machine ID to get your 
authorization code.   

If adding users, click on the Add Licenses button before generating the authorization 
code to get the most current machine ID. 
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Transfer Authorization 
 
The Transfer Licenses feature is used when moving a site license from one PC to 
another.  After Twin Client Manager is installed on a new PC, you will need the 
system/machine ID for it.  This ID appears in the first box of the authorization screen. 
 
From Twin Client Manager, select Authorization from under the Tools menu. 

 
Click on the Transfer Authorization button on the old PC. You will be asked for the 
new system ID.  Enter this new system ID.  It will generate an authorization code for the 
new PC's Twin Client Manager.   

 

 
 
 

Note: This feature only works if there are licenses remaining on the old PC. 
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Listing 

Click on the Listing button to view authorization codes used along with corresponding 
serial numbers. 

 
 
Click on OK when finished. 

Click on the Close button when finished. 
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Software Management 
In addition to providing functions for the download of files to the terminal via the 
traditional serial connection, the Twin Client Manager also provides for the management 
of terminal software and configurations automatically over the wireless network. 

Software Management describes the automated capability in detail. Additional manual 
operations involving serial download options are described at the end of this section. 

Airloader Auto-Configuration 
The Airloader Auto-Configuration form is accessed from the Twin Client Manager Tools 
menu. Select Airloader. 

 
Note: If no options are displayed, click the Advanced<< button. 

Enabling Automatic Downloads 

Click to put a check in the box that allows terminals to be automatically configured via 
RF to enable automatic downloading. In the event that another PC on the network is 
already configured and active, the following warning message is displayed. 
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Synchronizing Configuration Files 

Click to put a check in the Synchronize Configuration Files box to enable automatic 
synchronization of configuration files on the terminal. When the terminal is cold booted, 
its configuration files will be compared with the most recent on the PC. The terminal is 
updated automatically if it does not have the latest revision. 

Synchronizing Program Files 

Click to put a check in the Synchronize Program Files box to enable automatic 
synchronization of program files on the terminal. When the terminal is cold booted, its 
program files will be compared with the most recent on the PC. The terminal is updated 
automatically if it does not have the latest revision. 

Automatic IP Address Assignment 

New terminals will be assigned IP addresses automatically if the following box is 
checked. 

 
Note: Do not check this option if a DHCP server is configured to manage address 

assignments. 

To set the addresses, click on the Addresses button to access the Segment Address 
Assignments dialog box, as shown in the following figure. 
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Enter the desired range in the From and To boxes as shown above, and then click on 
Add. 

Creating New Groups 

New groups, with different configurations, can be created by clicking on 
Terminal/Group Manager, and then clicking the right mouse button as shown. 

 

After the new group has been created, the group settings option becomes available for 
change, as shown below. 
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After the Configuration File and all of the other parameters have been set, the group is 
made active by clicking on the Active check box. 
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Clicking on the Thin Mode button will cause all terminals in this group that are currently 
running in thick mode to be switched to thin mode the next time Airloader is run on the 
terminal. 
 
Click on the Schedule button to view a dialog box for scheduling an automatic Airloader 
update. 

 

 

Select the desired time and click on OK. Click on Update Now and the Airloader “push” 
capability controls terminals from this end. 
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Setting the Segment 

Checking the Segment button restricts a terminal group to a range of IP addresses. The 
IP Address can be any valid address on the segment, as it is used only to identify the 
segment. The setting of the Net Mask can be used to restrict the range.  This feature is 
useful for segregating terminal groups by location. 

Setting Force Reload 

Clicking on the Force Reload button forces all terminals within a group to be 
automatically updated. The following warning message appears. 

 

Click on the Yes button to force the reload. 

Setting the Default Terminal Group 

New terminals that have not yet been assigned to any group are initially assigned to the 
default group in effect when they are cold booted. 

 

Any group can be made the default group by clicking on the group, and then clicking on 
the right mouse button. Then click on the Make Default option. 

Reassigning Terminals 

After a terminal has been configured and assigned to the default group, it can be 
reassigned to a new group by clicking on the terminal icon as shown below. 

 

Then, holding the mouse button down, drag the terminal icon to the desired group as 
shown next. 
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Release the mouse button, which reassigns the terminal. 

 

The next time the terminal is rebooted, it will be reconfigured as defined in the group 
specification. 

Mobile Device Manager (MDM) Features 
 
Under Tools in Twin Client Manager are the Screen Watcher, Terminal Messenger, and 
RF Monitor features. 
 
Note: The terminal may or may not be able to utilize the Screen Watcher or Terminal 

Messenger features depending on its authorization codes.  
 

 
 

Select Screen Watcher, enter the terminal’s IP address, and click on OK. 
 

 
 

A screen will appear with a display resembling the terminal screen. 
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Clicking on the Font button on the upper left brings up a screen in which you can modify 
the font settings, as shown below. 

 

 
 
 
Select Terminal Messenger from the Tools menu.  
 
You may enter an Address Range in the From and To boxes on this screen. Click on Add 
when finished. 
 
Enter a message to send in the space provided, select the terminal to receive this message 
by clicking on it in the Select Terminal(s) column, and click on the Send button to send 
the message of your choice to the terminal of your choice. 
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See the example of the Terminal Messenger screen below. 
 

 
 

To remove a terminal from the list of terminals receiving your message, click on the 
terminal number in the Select Terminal(s) column, and click on the Remove button. 
Click on the appropriate button, Remove All, Select All, or Unselect All, to remove all 
terminals, select all terminals, or unselect all terminals from the Select Terminal(s) list. 
 
Note: Use the Ctrl and Shift keys to select multiple terminals. 
 
Click on the Close button when finished. 
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Select RF Monitor from the Tools menu. 
 

 
 

RF Monitor is an "Over The Air" diagnostic tool. It is used to collect diagnostic trace 
information from RF terminals running PowerNet Twin Client software. 

It runs on a Windows PC and will send a command to the RF terminal to start tracing. 
The terminal, when it receives this command, will start sending the trace information 
over the RF link to the PC that issued the command. This will be written to a file on this 
PC that can be sent to us for analysis. 

Click on File to Select Terminal or to Exit. 

 

Choosing Select Terminal allows you to view a log of the terminal’s activity. Enter the 
Terminal IP address and Terminal IP Port, and click on OK.  
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Click on Edit. Select Find and/or Find Next to search for pieces of information in your 
log, or select Clear to clear the search. 

 

Click on Actions to select Start Monitor or Stop Monitor. 

 

Click on Tools to choose Set Debug Levels or Settings. 

 
 

The options in Set Debug Levels are shown below. 
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The maximum log file size can be set under Settings. 

 

Click on View to show or hide the Toolbar and the Status Bar.  

 

This is the Toolbar. It is found near the top of the screen. 

 

This is the Status Bar. It is found at the bottom of the screen. 

 

Click on About RF Monitor under Help to view version number information. Click on  
About Twin Client Manager under Help in the main menu to view the following screen. 
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RF Monitor is a very small program and does not even require installation. Just place it in 
a directory on your PC and create a shortcut to run it. It will run on all versions of 
Windows except V3.1 and Windows 95.  

 
1. Move RF Monitor to a Windows PC with Network access to the RF terminal. 
 
2. Run RF Monitor. (Create a shortcut or do a Start/Run.) 
 
3. From the pull down menu, select File/Select Terminal. 
 
4. Key in the RF terminal IP address and leave the port at 1802. 

 

 
 
5. From the pull down menu, select Tools/Set Debug Levels. Set all levels to 9 except 

Datastream and SNA. 
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6. With the RF terminal sitting at the Press Any Key prompt, select Actions/Start 
Monitor. 
 

7. Press a key on the RF terminal to open a session, and you should see trace data in the 
RF Monitor window. When done, end the trace and the file will be named 
tnxxx.yyy.log (where xxx.yyy is the last 2 octets of the RF terminal’s IP address) in 
the directory in which RF Monitor was running. 
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Common Problems with RF Monitor 
 

• The trace won’t start.  

RF Monitor uses UDP to send commands to the RF device. On busy networks, UDP 
packets are not always delivered. The terminal can miss the command to start the 
trace. Below are some things that can be useful. 
 
a.   Ping the RF terminal from the PC used before starting RF Monitor. (This seems 

to "open" a path to the terminal.) 

b.   Start the Monitor with the terminal at the Press Any Key prompt. (While the 
terminal is at this prompt, it is not doing much and has a better chance of hearing 
the start trace command.) 

 
• I don't understand what this trace means. 

 
The trace that this tool collects is engineering-level information. It allows an end user 
to collect information that can be analyzed by Connect engineering. 
 
It will generally be requested by Connect support to help diagnose a reported 
problem. 
 
To be able to read and understand these completely, you need to have an 
understanding of: 
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a. Emulation protocols (IBM 5250, IBM 3270, DEC VT200, etc.) 
b. PowerNet Twin Client products 
c. RF Network concepts 
d. Wired network concepts 
e. Telnet sessions 
f.  TCP/IP  

 

They are text files that can be read with any editor or viewer and can be useful to end 
users and integrators, even if they may not have all the requirements above. 
 

• I have an intermittent problem and it could happen on any one of my 100 
terminals. RF Monitor only does one terminal at a time. What can I do? 
 
RF Monitor is not the right diagnostic tool for this type of problem. PowerNet 
products have another diagnostic tool that can be used called the "Diagnostic Server".  
 
This tool can be set up to run trace diagnostics on up to 300 terminals at the same 
time. This tool will be provided as needed for systems under PowerNet support 
agreement OR by T&M when they are not covered. 

It also includes the service of a PowerNet support engineer. 

 
Server Transfer is another feature. From the Tools menu, select Server Transfer. 

 
The FTP Settings screen appears. 

 
 

To send object editor and configuration files from Windows to your Linux box, enter 
your server address, and click on OK. 
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Manual Download of Configuration Files 
Hand Held Products terminals are normally delivered with Hand Held Products software 
pre-installed. Consult Hand Held Products Technical documentation for the current files 
and version numbers. 

The automated configuration management provided by the Twin Client Manager 
eliminates the need for a serial download of the terminal configuration. However, this 
function can be accomplished manually by clicking on Terminal and Send 
Configuration Files to Terminal. After safe booting the terminal, type “LD” at the DOS 
prompt, but do not Enter at this time. 

Note: This procedure assumes that the PowerNet Twin Client was previously installed. 

 

The following screen appears. 

 

Now, choose Enter on the terminal, while choosing OK at the prompt above. 

Cold boot the terminal. 

The terminal is now ready to begin a Telnet session with the new configuration files. 
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Keypad Figures 
   
  
 
  
   
 
 
 
 
   
 
 
 
 
 
  
 
 
 
  
  

 
Hand Held 
Products

Supported Equipment Manual   •    March, 2006                                                                                              3-1



Keypad Configuration 

 _ 
_

                

Sys Rq

 
 
Home1 2 3 4 5 6 7 

0 

7 

    F3 F4   F6   F5   F2       
    
 

  F1   Esc   F9  F8  F7   F11 F12   Pause
Break 

  Scroll  
Lock 

  
SysRq 

Prt Sc
 

  F10 

&% ^ $ @ # ! 

= 

  
Backspace 
←   

8 9 0 

  )   (   * 

  

Shift 

  X   C   Z   V   B   N   M   <
,

  >
.

 
 /

?   

      :                   F LA S D G H J K Pg Dn

 
 

; Enter
← 

 
Caps 
Lock 

  

        U I   
\  

  }   Pg Up |   {   O P  T E R   Y   W   Q  ← 
→  
Tab 

 Fn 

  Alt     Ctrl 
Space 

    Alt   Ins   Del 

Hand Held Products Dolphin 7500 Keyboard 

3-2  Supported Equipment Manu
 
‘
“

]

↑
Shift 

        End

↓  ←     →
`` 
  
  _  

  

 +
[ 
 

al  
  Num 
Lock
 ~
 •   March, 2006 



 

   Keypad Configuration 

Keypad Table 
 

The keypad table in this section is organized by emulation. The key values represent the default keypad 
assignments applied to the terminal in Twin Client advanced mode.     

    
Key VTERM 3270 5250 
a <a> <a> <a> 
b <b> <b> <b> 
c <c> <c> <c> 
d <d> <d> <d> 
e <e> <e> <e> 
f <f> <f> <f> 
g <g> <g> <g> 
h <h> <h> <h> 
i <i> <i> <i> 
j <j> <j> <j> 
k <k> <k> <k> 
l <l> <l> <l> 
m <m> <m> <m> 
n <n> <n> <n> 
o <o> <o> <o> 
p <p> <p> <p> 
q <q> <q> <q> 
r <r> <r> <r> 
s <s> <s> <s> 
t <t> <t> <t> 
u <u> <u> <u> 
v <v> <v> <v> 
w <w> <w> <w> 
x <x> <x> <x> 
y <y> <y> <y> 
z <z> <z> <z> 
A <Shift><a> <Shift><a> <Shift><a> 
B <Shift><b> <Shift><b> <Shift><b> 
C <Shift><c> <Shift><c> <Shift><c> 
D <Shift><d> <Shift><d> <Shift><d> 
E <Shift><e> <Shift><e> <Shift><e> 
F <Shift><f> <Shift><f> <Shift><f> 
G <Shift><g> <Shift><g> <Shift><g> 
H <Shift><h> <Shift><h> <Shift><h> 
 I <Shift><i> <Shift><i> <Shift><i> 
J <Shift><j> <Shift><j> <Shift><j> 
K <Shift><k> <Shift><k> <Shift><k> 
L <Shift><l> <Shift><l> <Shift><l> 
M <Shift><m> <Shift><m> <Shift><m> 
N <Shift><n> <Shift><n> <Shift><n> 
O <Shift><o> <Shift><o> <Shift><o> 
P <Shift><p> <Shift><p> <Shift><p> 
Q <Shift><q> <Shift><q> <Shift><q> 
R <Shift><r> <Shift><r> <Shift><r> 
S <Shift><s> <Shift><s> <Shift><s> 
T <Shift><t> <Shift><t> <Shift><t> 
U <Shift><u> <Shift><u> <Shift><u> 
V <Shift><v> <Shift><v> <Shift><v> 
W <Shift><w> <Shift><w> <Shift><w> 
X <Shift><x> <Shift><x> <Shift><x> 
Y <Shift><y> <Shift><y> <Shift><y> 
Z <Shift><z> <Shift><z> <Shift><z> 
Backtab <Shift><Tab> <Shift><Tab> <Shift><Tab> 
Tab ←  → <Tab> <Tab> <Tab> 
Esc <Esc> <Esc> <Esc> 
Space <Space> <Space> <Space> 
Caps Lock <Caps Lock> <Caps Lock> <Caps Lock> 
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Shift <Shift> <Shift> <Shift> 
Ctrl <Ctrl> <Ctrl> <Ctrl> 
Alt <Alt> <Alt> <Alt> 
Backspace ← <Backspace> <Backspace> <Backspace> 
Enter <Enter> <Enter> <Enter> 
Del <Del> <Del> <Del> 
1 <1> <1> <1> 
2 <2> <2> <2> 
3 <3> <3> <3> 
4 <4> <4> <4> 
5 <5> <5> <5> 
6 <6> <6> <6> 
7 <7> <7> <7> 
8 <8> <8> <8> 
9 <9> <9> <9> 
0 <0> <0> <0> 
! <Shift><1> <Shift><1> <Shift><1> 
@ <Shift><2> <Shift><2> <Shift><2> 
# <Shift><3> <Shift><3> <Shift><3> 
$ <Shift><4> <Shift><4> <Shift><4> 
% <Shift><5> <Shift><5> <Shift><5> 
^ <Shift><6> <Shift><6> <Shift><6> 
& <Shift><7> <Shift><7> <Shift><7> 
* <Shift><8> <Shift><8> <Shift><8> 
( <Shift><9> <Shift><9> <Shift><9> 
) <Shift><0> <Shift><0> <Shift><0> 
F1 <F1> <F1> <F1> 
F2 <F2> <F2> <F2> 
F3 <F3> <F3> <F3> 
F4 <F4> <F4> <F4> 
F5 <F5> <F5> <F5> 
F6 <F6> <F6> <F6> 
F7 <F7> <F7> <F7> 
F8 <F8> <F8> <F8> 
F9 <F9> <F9> <F9> 
F10 <F10> <F10> <F10> 
F11 <F11> <F11> <F11> 
F12 <F12> <F12> <F12> 
F11 <Shift><F1> <Shift><F1> <Shift><F1> 
F12 <Shift><F2> <Shift><F2> <Shift><F2> 
F13 <Shift><F3> <Shift><F3> <Shift><F3> 
F14 <Shift><F4> <Shift><F4> <Shift><F4> 
F15 <Shift><F5> <Shift><F5> <Shift><F5> 
F16 <Shift><F6> <Shift><F6> <Shift><F6> 
F17 <Shift><F7> <Shift><F7> <Shift><F7> 
F18 <Shift><F8> <Shift><F8> <Shift><F8> 
F19 <Shift><F9> <Shift><F9> <Shift><F9> 
F20 <Shift><F10> <Shift><F10> <Shift><F10> 
F21 <Shift><F11> <Shift><F11> <Shift><F11> 
F22 <Shift><F12> <Shift><F12> <Shift><F12> 
F21 <Ctrl><F1> <Ctrl><F1> <Ctrl><F1> 
F22 <Ctrl><F2> <Ctrl><F2> <Ctrl><F2> 
F23 <Ctrl><F3> <Ctrl><F3> <Ctrl><F3> 
F24 <Ctrl><F4> <Ctrl><F4> <Ctrl><F4> 
↑ <↑> <↑> <↑> 
← <←> <←> <←> 
↓ <↓> <↓> <↓> 
→ <→> <→> <→> 
/                 forward slash </> </> </> 
`                              accent <`> <`> <`> 
-                            hyphen <-> <-> <-> 
=                      equal sign <=> <=> <=> 
[                      left bracket <[> <[> <[> 
]                   right bracket <]> <]> <]> 
\              backward slash <\> <\> <\> 
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;                       semicolon <;> <;> <;> 
‘                      apostrophe <’> <’> <’> 
,                             comma <,> <,> <,> 
.                              period <.> <.> <.> 
~                                 tilde <Shift><`> <Shift><`> <Shift><`> 
_                    underscore <Shift><-> <Shift><-> <Shift><-> 
+                  addition sign <Shift><=> <Shift><=> <Shift><=> 
{                        left brace <Shift><[> <Shift><[> <Shift><[> 
}                      right brace <Shift><]> <Shift><]> <Shift><]> 
|        broken vertical bar <Shift><\> <Shift><\> <Shift><\> 
:                               colon <Shift><;> <Shift><;> <Shift><;> 
“              quotation mark <Shift><’> <Shift><’> <Shift><’> 
<                less-than sign <Shift><,> <Shift><,> <Shift><,> 
>          greater-than sign <Shift><.> <Shift><.> <Shift><.> 
?               question mark <Shift></> <Shift></> <Shift></> 
Print Screen/Sys Req <Prt Sc/SysRq> <Prt Sc/SysRq> <Prt Sc/SysRq> 
Pause/Break <Pause Break> <Pause Break> <Pause Break> 
Scroll Lock <Scroll Lock> <Scroll Lock> <Scroll Lock> 
Insert <Ins> <Ins> <Ins> 
Home <Home> <Home> <Home> 
End <End> <End> <End> 
Page Up <Pg Up> <Pg Up> <Pg Up> 
Page Down <Pg Dn> <Pg Dn> <Pg Dn> 
Num Lock <Num Lock> <Num Lock> <Num Lock> 
Roll up --- --- <Alt><↑> 
Roll down  --- --- <Alt><↓> 
View up <Ctrl><↑> <Ctrl><↑> <Ctrl><↑> 
View down <Ctrl><↓> <Ctrl><↓> <Ctrl><↓> 
View left <Ctrl><←> <Ctrl><←> <Ctrl><←> 
View right <Ctrl><→> <Ctrl><→> <Ctrl><→> 
Lighten <Alt><→> <Alt><→> <Alt><→> 
Darken <Alt><←> <Alt><←> <Alt><←> 
PA1 --- <Alt><1> --- 
PA2 --- <Alt><2> --- 
PA3 --- <Alt><3> --- 
ERINP --- <Alt><End> <Alt><End> 
Attention --- <Alt><a> <Alt><a> 
Bottom --- <Alt><b> <Alt><b> 
Clear --- <Alt><c> <Alt><c> 
Redraw --- <Alt><d> <Alt><d> 
Field exit --- --- <Alt><e> 
FM --- <Alt><f> <Alt><f> 
Field mark --- --- --- 
Help <Alt><h> <Alt><h> <Alt><h> 
Info <Alt><i> <Alt><i> <Alt><i> 
EOF --- <Alt><j> <Alt><j> 
Erinp --- <Alt><k> <Alt><k> 
Local exit --- <Alt><l> <Alt><l> 
Field - --- --- <Alt><m> 
New line --- <Alt><n> <Alt><n> 
ErEOF --- --- <Alt><o> 
Field + --- --- <Alt><p> 
Reset --- <Alt><r> <Alt><r> 
Sys req --- <Alt><s> <Alt><s> 
Top --- <Alt><t> <Alt><t> 
Dup --- <Alt><u> <Alt><u> 
Refresh --- <Alt><v> <Alt><v> 
Print --- <Alt><w> <Alt><w> 
Null end --- <Alt><x> <Alt><x> 
Back tab <Alt><y> <Alt><y> <Alt><y> 
EndPos --- <Alt><z> <Alt><z> 
Ctrl_a <Ctrl><a> <Ctrl><a> <Ctrl><a> 
Ctrl_b <Ctrl><b> <Ctrl><b> <Ctrl><b> 
Ctrl_c <Ctrl><c> <Ctrl><c> <Ctrl><c> 
Ctrl_d <Ctrl><d> <Ctrl><d> <Ctrl><d> 
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Ctrl_e <Ctrl><e> <Ctrl><e> <Ctrl><e> 
Ctrl_f <Ctrl><f> <Ctrl><f> <Ctrl><f> 
Ctrl_g <Ctrl><g> <Ctrl><g> <Ctrl><g> 
Ctrl_h <Ctrl><h> <Ctrl><h> <Ctrl><h> 
Ctrl_I <Ctrl><i> <Ctrl><i> <Ctrl><i> 
Ctrl_j <Ctrl><j> <Ctrl><j> <Ctrl><j> 
Ctrl_k <Ctrl><k> <Ctrl><k> <Ctrl><k> 
Ctrl_l <Ctrl><l> <Ctrl><l> <Ctrl><l> 
Ctrl_m <Ctrl><m> <Ctrl><m> <Ctrl><m> 
Ctrl_n <Ctrl><n> <Ctrl><n> <Ctrl><n> 
Ctrl_o <Ctrl><o> <Ctrl><o> <Ctrl><o> 
Ctrl_p <Ctrl><p> <Ctrl><p> <Ctrl><p> 
Ctrl_q <Ctrl><q> <Ctrl><q> <Ctrl><q> 
Ctrl_r <Ctrl><r> <Ctrl><r> <Ctrl><r> 
Ctrl_s <Ctrl><s> <Ctrl><s> <Ctrl><s> 
Ctrl_t <Ctrl><t> <Ctrl><t> <Ctrl><t> 
Ctrl_u <Ctrl><u> <Ctrl><u> <Ctrl><u> 
Ctrl_v <Ctrl><v> <Ctrl><v> <Ctrl><v> 
Ctrl_w <Ctrl><w> <Ctrl><w> <Ctrl><w> 
Ctrl_x <Ctrl><x> <Ctrl><x> <Ctrl><x> 
Ctrl_y <Ctrl><y>  <Ctrl><y> <Ctrl><y> 
Ctrl_z <Ctrl><z> <Ctrl><z> <Ctrl><z> 
Ctrl ^ <Ctrl><6> <Ctrl><6> <Ctrl><6> 
Ctrl _ <Ctrl><-> <Ctrl><-> <Ctrl><-> 
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Twin Client Error Message Resolution Guide 

 
Message Reason Solution Reference Tech Note 

ENTRY TOO LONG; Trying to key beyond the field size. Ensure that you are entering input into 
the correct field. 

--- 

ALPHABETIC ONLY; Trying to key a character that is not 
alphabetic. 

Ensure that you are entering input into 
the correct field. 

--- 

MINUS NOT VALID; Trying to key a Minus sign. Ensure that you are entering input into 
the correct field. 

--- 

DECIMAL NOT VALID; Trying to key a Decimal (period). Ensure that you are entering input into 
the correct field. 

--- 

ALPHANUMERIC ONLY; Trying to key characters other than 
Alphabetic and numeric. 

Ensure that you are entering input into 
the correct field. 

--- 

NUMERIC ONLY; Trying to key characters other than 
numeric. 

Ensure that you are entering input into 
the correct field. 

--- 

ENTRY TOO SHORT; Trying to exit the field before it is 
filled. 

Ensure that you are entering input into 
the correct field. 

--- 
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Message Reason Solution Reference Tech Note 
    

INVALID KEY; The key pressed is not valid. Ensure that you are entering input into 
the correct field. 

--- 

MUST CLEAR FIELD; Trying to enter data in a field that 
must be cleared first. 

Ensure that you are entering input into 
the correct field. 

--- 

SCAN NOT ALLOWED; Trying to scan into a key only field. Ensure that you are entering input into 
the correct field. 

--- 

KEY NOT ALLOWED; Trying to key into a scan only field. Ensure that you are entering input into 
the correct field. 

--- 

ENTRY TOO SHORT; Trying to exit the field before it is 
filled. 

Ensure that you are entering input into 
the correct field. 

--- 

RECOVERABLE ERROR; Encountered an error from which 
you can continue. 

Verify that your configuration settings 
for the hardware being used, usually a 
printer and cable issue. 

--- 

UNRECOVERABLE ERROR; Encountered an error from which 
you can NOT continue. 

Verify that your Network settings are 
correct and you are in the correct mode 
using the correct Port. 
 

T1113, T1114, T1161, 
T1171, T1187 and 
T1194 

FUNCTION: \n\nFILE: \nLINE: \nCODE; Encountered an error from which 
you can NOT continue. 

Notify Connect over the WEB incident 
reporting system. 

--- 

Press any key\nFor More Details...; Press Enter for more information. Advisory message. --- 

Press any key; Press a key to continue. Advisory message. --- 
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Message Reason Solution Reference Tech Note 
    

Connection ERROR.\nREBOOT 
MOBILE UNIT; 

Could not Connect. Verify that your Network settings are 
correct and you are in the correct mode 
using the correct Port. 
 

T1113, T1114, T1161, 
T1171, T1187 and 
T1194 

Disconnect ERROR.\nREBOOT 
MOBILE UNIT; 

Could not Disconnect. Verify that your Network settings are 
correct and you are in the correct mode 
using the correct Port. 
 

T1113, T1114, T1161, 
T1171, T1187 and 
T1194 

RF Send ERROR.\nREBOOT MOBILE 
UNIT; 

Could not Send. Most likely a range, access point, radio, 
host or network issue. Troubleshoot the 
customer’s environment. 

T1113, T1114, T1161, 
T1171, T1187 and 
T1194 

RF Receive ERROR.\nREBOOT 
MOBILE UNIT; 

Could not Receive. Most likely a range, access point, radio, 
host or network issue. Troubleshoot the 
customer’s environment. 

T1113, T1114, T1161, 
T1171, T1187 and 
T1194 

RF Check ERROR.\nREBOOT 
MOBILE UNIT; 

Could not run the RF Survey. Most likely a range, access point, radio, 
host or network issue. Troubleshoot the 
customer’s environment. 

T1113, T1114, T1161, 
T1171, T1187 and 
T1194 

RF Timeout ERROR.\nREBOOT 
MOBILE UNIT; 

Have been trying to contact the 
host for the radio timeout period (2 
minutes default). 

Most likely a range, access point, radio, 
host or network issue. Troubleshoot the 
customer’s environment. 

T1113, T1114, T1161, 
T1171, T1187 and 
T1194 

REBOOT MOBILE UNIT; Reboot the Mobile Unit do to loss 
of connection. 

Most likely a range, access point, radio, 
host or network issue. Troubleshoot the 
customer’s environment. 

T1113, T1114, T1161, 
T1171, T1187 and 
T1194 

Retry (Y/N)?; Try again. Try to send or receive again, or perhaps 
ensure that the printer is cabled to the 
Mobile Unit and is on. 
 

--- 
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Message Reason Solution Reference Tech Note 
    

TIMEOUT\n\nSending Data; Mobile Unit out of the coverage 
area. 

Most likely a range, access point, radio, 
host or network issue. Troubleshoot the 
customer’s environment. 

T1113, T1114, T1161, 
T1171, T1187 and 
T1194 

TIMEOUT\n\nReceiving Data; Mobile Unit out of the coverage 
area. 

Most likely a range, access point, radio, 
host or network issue. Troubleshoot the 
customer’s environment. 

T1113, T1114, T1161, 
T1171, T1187 and 
T1194 

Host Received Data\nAwaiting App 
Reply!; 

Mobile Unit has sent and received 
an acknowledgement from the IP 
stack and is waiting for the 
application to return data. 

Most likely a host or network issue. 
Troubleshoot the customer’s 
environment. Probable causes are 
Database record locking, application 
program failure, Host failure or network 
failure. 

T1113, T1114, T1161, 
T1171, T1187 and 
T1194 

* WAITING TO SEND  *; Mobile Unit out of the coverage 
area. 

Most likely a range, access point, radio, 
host or network issue. Troubleshoot the 
customer’s environment. 

T1113, T1114, T1161, 
T1171, T1187 and 
T1194 

TCP Error Reading\nMAC 
Address.\nREBOOT MOBILE UNIT; 

Could not obtain the Mac Address 
from the Mobile Unit. 

Possible hardware, driver or stack 
problem Contact the Mobile Unit 
manufacturer. 

--- 

Invalid TIP Command; Bad internal protocol. Notify Connect over the WEB incident 
reporting system. 

--- 

Session Ended\nBy User or Host; User, Host, application or network 
has ended the session. 

If the user did not end the session, most 
likely host or network issues. 
Troubleshoot the customer’s 
environment. 

T1113, T1114, T1161, 
T1171, T1187 and 
T1194 

Server Packet Error; Bad Protocol detected. Usually a result of bad cabling, power or 
faulty transceiver. Also, will receive this 
if the Mobile Unit is in the wrong mode 
for server operation. 

--- 
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Error receiving host\nlist from Server; Bad Protocol detected. Usually a result of bad cabling, power or 
faulty transceiver. Also, will receive this 
if the Mobile Unit is in the wrong mode 
for server operation. 

--- 

Unexpected Server\ndata received; Bad Protocol detected. Usually a result of bad cabling, power or 
faulty transceiver. Also, will receive this 
if the Mobile Unit is in the wrong mode 
for server operation. 

--- 

Error starting\nhost application; Connected to the server but can 
not connect to the distant end. 

Configure the server handler to access 
the host application. 

--- 

Select Host or App; Need to choose your 
Host/application destination. 

User selection required. --- 

Connecting...; Attempting to connect to the 
Host/application. 

Advisory message. --- 

TCP Error\nReading IP 
Address\nREBOOT MOBILE UNIT; 

Mobile Unit missing Network IP 
information. 

Configure the Mobile Unit with the 
correct network IP information. 

--- 

Printer start error; Could not initialize the printer. 
 
 

Cable or power issue with the printer. --- 

Battery too low\nto print; Not enough power to print. Replace the battery with a fully 
recharged battery. 
 

--- 

Paper Feed Error\nFix Then Hit Enter; Paper in the printer is not ready. Replace the paper or rethread the 
paper in the printer. 
 

--- 

Printer Error\nPrint Ended; Can not print. Check cable, battery, communication 
settings and paper in the printer. 

--- 
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User Count Exceeded.\n Session 
Ended;  

Possible authorization issue. Verify that you have the correct number 
of licenses for the number of Mobile 
Units you are using. 
 

--- 

Primary Unavailable\nTrying Alternate; First Host IP address not available 
trying the remaining addresses in 
the Host list. 

Verify the host address. --- 

APMAC.DAT Error\nSession Ended; Access point Media Access Control 
error. 

Most likely a range, access point, radio, 
host or network issue. Troubleshoot the 
customer’s environment. 

T1113, T1114, T1161, 
T1171, T1187 and 
T1194 

MUIP.DAT Error\nSession Ended;  Mobile Unit IP Error. Most likely a Mobile Unit network setting 
issue. Troubleshoot the customer’s 
environment. 
 

T1113, T1114, T1161, 
T1171, T1187 and 
T1194 

Missing Subnet IP\nSession Ended;  Mobile Unit IP Netmask Error. Most likely a Mobile Unit network setting 
issue. Troubleshoot the customer’s 
environment. 
 

T1113, T1114, T1161, 
T1171, T1187 and 
T1194 

Error Opening File;  File is missing. Verify that the configuration files are on 
the Mobile Unit.  Or perhaps there is a 
hardware failure. 

--- 

Telnet API\nnot found; Program files are missing. Reload program files. --- 

Battery Low Warning\n\nReplace 
Battery Soon;  

Not enough power to operate the 
Mobile Unit. 

Replace the battery with a fully 
recharged battery. 

--- 

No Host List.\nPress any key\nTo Edit 
Host IP's;  

Have not configured your target 
hosts. 

Configure the target host IP addresses. --- 

Unable to Allocate\nFont Memory; Mobile Unit does not have enough 
memory to load the fonts. 

Reduce the fonts in use or expand the 
memory in the Mobile Unit. 

--- 
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Font Loading Error; Could not load the font. 
 
 

Ensure that the font is available to load. --- 

Printer Not Ready\nPress R to 
Retry\nC to Cancel Print; 

Can not print. Check cable, battery, communication 
settings and paper in the printer. 

--- 

Mobile Unit in\nDemonstration 
Mode\nfor TwinClient;  

Running in demo mode. Purchase a license from Connect. --- 

Connected to Host;  Successful connection to the target 
Host. 

Advisory message. --- 

Telnet Mode not\nsupported on\nthis 
Mobile Unit;  

This Mobile Unit must be used with 
a Connect Server. 

Order a Connect Server. --- 

Telnet Setup files\nnot found. 
Reload\nfiles then switch;  

Customer specific configuration 
files are missing. 

Load the configuration files into the 
Mobile Unit from Twin Client Manager. 

--- 

Switched Client to\nTelnet Direct Mode; Mobile Unit running in Telnet mode 
direct to the target Host. 
 

Advisory message. --- 

Switched Client to\nServer Based 
Mode;  

Mobile Unit running through a 
Connect server in Server mode 
usually at port 1800. 

Advisory message. --- 

Port 23 is only\nallowed in Telnet 
Mode;  

Can not set the port to 23 in Server 
mode.  Port 23 is the standard 
Telnet port. 

Advisory message. --- 

Not Enough Memory\nTo Run; Mobile Unit does not have the 
capacity to run the program do to 
memory restrictions. 

Expand the Mobile Unit memory. --- 

Press any key; Press a key to continue. Advisory message. --- 
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TwinClient Telnet;  Prompt. Advisory message. --- 

TwinClient Server;  Prompt. Advisory message. --- 

TwinClient TN3270; Prompt. Advisory message. --- 

TwinClient TN5250; Prompt. Advisory message. --- 

TwinClient TNVT; Prompt. Advisory message. --- 

(c) 1991-2006 Connect; Prompt. Advisory message. --- 

Edit Menu Options; Menu Title. Advisory message. --- 

Edit Mobile Unit IP; Menu Option. Advisory message. --- 

Edit Server/Host IPs; Menu Option. Advisory message. --- 

Edit Radio Option; Menu Option. Advisory message. --- 
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Edit License Key;  Menu Option. Advisory message. --- 

Run Site Survey;  Menu Option. Advisory message. --- 

Switch Client Modes; Menu Option. Advisory message. --- 

Run TwinClient; Menu Option. Advisory message. --- 

Exit to OS;  Menu Option. Advisory message. --- 

Printer may not be\nplugged in 
or\nturned on!; 

Can not print. Check cable, battery, communication 
settings and paper in the printer. 

--- 

OUT OF RANGE OF BASE; Mobile Unit out of the coverage 
area. 

Most likely a range, access point, radio, 
host or network issue. Troubleshoot the 
customer’s environment. 

T1113, T1114, T1161, 
T1171, T1187 and 
T1194 

CONNECT SERIAL CABLE; Serial cable not connected to the 
Mobile Unit. 

Check cable, battery and 
communication settings for the Mobile 
Unit. 

--- 

REMOVE SERIAL CABLE; Remove serial cable from to the 
Mobile Unit. 

Check cable, battery and 
communication settings for the Mobile 
Unit. 

--- 

PLACE IN CRADLE; Place the Mobile Unit in the cradle. Advisory message. --- 
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REMOVE FROM CRADLE; Remove Mobile Unit from the 
cradle. 

Advisory message. --- 

ACQUIRING CRADLE BUS;  Attempting to access the cradle 
through the serial port you have 
configured. 

Advisory message. --- 

Printer Out\nOf Range; Printer out of the coverage area. Most likely a range, access point or 
radio issue. Troubleshoot the 
customer’s environment. 
 

T1113, T1114, T1161, 
T1171, T1187 and 
T1194 

Connection Refused\nBy Host; You connected to the target host 
but the host disconnected you. 

Verify that the configuration file has the 
correct Mobile Unit type and New 
environment variable set.  Fallback to 
the Connect Default to verify the 
connection. 

--- 

Connection Timed Out; You connected to the host but did 
not logon in the appropriate time so 
the host disconnected you. 

Modify the Host parameters for login. --- 

Connection Failed\nHost Not 
Responding; 

Could not connect to the Host. Most likely a range, access point, radio, 
host or network issue. Troubleshoot the 
customer’s environment. 

T1113, T1114, T1161, 
T1171, T1187 and 
T1194 

Connection Failed\nHost Unreachable; Could not connect to the Host. Most likely a range, access point, radio, 
host or network issue. Troubleshoot the 
customer’s environment. 

T1113, T1114, T1161, 
T1171, T1187 and 
T1194 

Mobile Unit Out\nOf Range, 
Unable\nTo Transmit; 

Mobile Unit out of the coverage 
area. 

Most likely a range, access point, radio, 
host or network issue. Troubleshoot the 
customer’s environment. 

T1113, T1114, T1161, 
T1171, T1187 and 
T1194 
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Mobile Unit Out\nOf Range, 
Unable\nTo Receive; 

Mobile Unit out of the coverage 
area. 

Most likely a range, access point, radio, 
host or network issue. Troubleshoot the 
customer’s environment. 

--- 

Printer Not\nResponding; Can not print. Check cable, battery, communication 
settings and paper in the printer. 
 
 

--- 

Printer Out\nOf Range; Printer out of the coverage area. Most likely a range, access point or 
radio issue. Troubleshoot the 
customer’s environment. 
 

T1113, T1114, T1161, 
T1171, T1187 and 
T1194 

Print Complete; Prompt. Advisory message. --- 

Reprint (Y/N)?; Yes or No prompt for a reprint. Advisory message. --- 

WARNING;  Prompt. Advisory message. --- 

Turning power off\nduring a 
session\nwill cause the\nprogram to 
restart; 

This Mobile Unit will disconnect the 
session if powered off. 

Mobile Unit manufacturer limitation. 
Advisory message. 

--- 

Are you sure (y/n)?; Yes or No prompt for a 
confirmation. 

Advisory message. --- 

You Sure? (YyNn); Yes or No prompt for a 
confirmation. 

Advisory message. --- 
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Domain Name Server\nNot Set; DOMAIN NAME SERVER not 
configured. 

Configure the Mobile Unit with the 
correct network IP information. 

--- 

Domain Name Server\nQuery Memory 
Error; 

Memory error on the Mobile Unit Expand the Mobile Unit memory or 
return the Mobile Unit for repair. 

--- 

Domain Name Server\nQuery Sending 
Error; 

Mobile Unit out of the coverage 
area. 

Most likely a range, access point, radio, 
host or network issue. Troubleshoot the 
customer’s environment. 

T1113, T1114, T1161, 
T1171, T1187 and 
T1194 

Domain Name Server\nQuery Receive 
Error;  

Mobile Unit out of the coverage 
area. 

Most likely a range, access point, radio, 
host or network issue. Troubleshoot the 
customer’s environment. 

T1113, T1114, T1161, 
T1171, T1187 and 
T1194 

Domain Name Server\nUnavailable; Could not connect to the DOMAIN 
NAME SERVER. 

Most likely a range, access point, radio, 
host or network issue. Troubleshoot the 
customer’s environment. 

T1113, T1114, T1161, 
T1171, T1187 and 
T1194 

Error loading\nparameter file; Could not load the parameter file. Reload the correct configuration files. --- 

Could not open\ntelnet interface; Could not Telnet. Reload the program files. --- 

Could not set\mtelnet options; Could not use the Telnet 
configuration. 

Reload the correct configuration files. --- 

Setup file\nsetting mismatch\nReload 
Setup; 

Emulation program selected is not 
compatible with the configuration 
file on the Mobile Unit. 

Remove the emulation and 
configuration files. Run clear Telnet on 
the Mobile Unit then reload the Mobile 
Unit with the proper emulation and 
configuration files. 

--- 
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Display formatting\ntoo large 
for\ncurrent screen; 

Mobile Unit does not have enough 
memory to run your configured 
reformatted screens. 

Expand the Mobile Unit memory or 
order a server from Connect. 

--- 

Mobile Unit\ninitialization error; Mobile Unit problem. Return the Mobile Unit to the 
manufacturer for repair. 

--- 

Host/App/Network\nclosed the session; Customer’s environment 
disconnected the Mobile Unit 
session. 

Most likely a range, access point, radio, 
host or network issue. Troubleshoot the 
customer’s environment. 

T1113, T1114, T1161, 
T1171, T1187 and 
T1194 

Disconnecting...;   Prompt. Advisory message. --- 

Scan Barcode; Bar code scanning test. Advisory message. --- 

Enter Setup\nPassword;  Prompt. Advisory message. --- 

Enter Profile \nPassword; Prompt. Advisory message. --- 

Host IP; Host IP address prompt. Enter target host IP address. --- 

Host Name; Host name prompt. Enter target host Name. --- 

Port; Host IP port required. Enter 23 for Telnet or 1800 for a 
Connect server. Could also be a 
different number depending on the 
customer’s environment. 

T1113, T1114, T1161, 
T1171, T1187 and 
T1194 
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Mobile Unit Type;  Prompt. Advisory message. --- 

WARNING: This will \nend any\ncurrent 
session; 

Prompt. Advisory message. ---

Continue (Y/N)?; Prompt. Advisory message. --- 

HOST ENTRY; Prompt. Advisory message. --- 

VT(100/220) Setup; Prompt. Advisory message. --- 

Mobile Unit Info; Prompt. Advisory message. --- 

Emulation Setup; Prompt. Advisory message. --- 

ANSI Setup; Prompt. Advisory message. --- 

Miscellaneous Setup; Prompt. Advisory message. --- 

Mobile Unit Type; Prompt. Advisory message. --- 
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Control Codes; Prompt. Advisory message. --- 

Local Echo; Prompt. Advisory message. --- 

<BK SP> Sends; Prompt. Advisory message. --- 

New Line Mode; Prompt. Advisory message. --- 

Insert Mode; Prompt. Advisory message. --- 

Autowrap Mode; Prompt. Advisory message. --- 

Cursor; Prompt. Advisory message. ---

EMULATION SETUP; Prompt. Advisory message. --- 

Mobile Unit Type; Prompt. Advisory message. --- 

Local Echo; Prompt. Advisory message. --- 
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Map Underline; Prompt. Advisory message. --- 

Break Key; Prompt. Advisory message. --- 

ANSI Setup; Prompt. Advisory message. --- 

Control Codes; Prompt. Advisory message. --- 

Backspace Key; Prompt. Advisory message. --- 

MISCELLANEOUS SETUP; Prompt. Advisory message. --- 

Test Options; Prompt. Advisory message. --- 

Login Options; Prompt. Advisory message. --- 

TEST OPTIONS; Prompt. Advisory message. --- 

Printer Test; Prompt. Advisory message. --- 
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Scan Code Test; Prompt. Advisory message. --- 

LOGIN OPTIONS; Prompt. Advisory message. --- 

User Name; Prompt. Advisory message. --- 

User Password;  Prompt. Advisory message. --- 

ON; Prompt. Advisory message. ---

OFF; Prompt. Advisory message. ---

Map; Prompt. Advisory message. ---

Don't Map; Prompt. Advisory message. --- 

Enable Break; Prompt. Advisory message. --- 

Disable Break; Prompt. Advisory message. --- 
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7 bit; Prompt. Advisory message. --- 

8 bit; Prompt. Advisory message. --- 

Send Delete; Prompt. Advisory message. --- 

Send Backspace;  Prompt. Advisory message. --- 

Mobile Unit Setup; Prompt. Advisory message. --- 

Scanner Options; Prompt. Advisory message. --- 

Program Options; Prompt. Advisory message. --- 

Special Options;  Prompt. Advisory message. --- 

Beeper Options;  Prompt. Advisory message. --- 

Exit to DOS; Prompt. Advisory message. --- 
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Backlight Time; Prompt. Advisory message. --- 

Enter Key Action; Prompt. Advisory message. --- 

Reset Options; Prompt. Advisory message. --- 

Font Size;  Prompt. Advisory message. --- 

Portable Printer; Prompt. Advisory message. --- 

Reprint Option; Prompt. Advisory message. --- 

Data IDs; Prompt. Advisory message. --- 

Internal/External; Prompt. Advisory message. ---

Modify Beeps; Prompt. Advisory message. --- 

Message Beeps;  Prompt. Advisory message. --- 
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Scan Identifier; Prompt. Advisory message. --- 

AID Scan Setup; Prompt. Advisory message. --- 

Long Scans; Prompt. Advisory message. --- 

Scan Send;  Prompt. Advisory message. --- 

Yes; Prompt. Advisory message. ---

No;  Prompt. Advisory message. --- 

Normal; Prompt. Advisory message. ---

Double Wide; Prompt. Advisory message. --- 

Double High; Prompt. Advisory message. --- 

Double High and Wide; Prompt. Advisory message. --- 
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Errors Only; Prompt. Advisory message. --- 

Automatic; Prompt. Advisory message. ---

All Messages;  Prompt. Advisory message. --- 

Reject; Prompt. Advisory message. ---

Truncate; Prompt. Advisory message. ---

Split;  Prompt. Advisory message. --- 

Do Not Send; Prompt. Advisory message. --- 

Always Send; Prompt. Advisory message. --- 

Last Field Only; Prompt. Advisory message. --- 

Internal; Prompt. Advisory message. ---
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External; Prompt. Advisory message. ---

none; Prompt. Advisory message. ---

monarch; Prompt. Advisory message. ---

pddumb; Prompt. Advisory message. ---

comtec; Prompt. Advisory message. ---

rascal; Prompt. Advisory message. ---

codewriter; Prompt. Advisory message. ---

comtec(S); Prompt. Advisory message. ---

User Name; Prompt. Advisory message. --- 

Password;  Prompt. Advisory message. --- 

4-22  Supported Equipment Manual   •   March, 2006 



  Error Message Resolution Guide 

 

Message Reason Solution Reference Tech Note 
    

     

     

Frequency:      Hz; Prompt. Advisory message. --- 

Duration:       ms; Prompt. Advisory message. --- 

Delay:          ms;  Prompt. Advisory message. --- 

Select Scanner; Prompt. Advisory message. --- 

Setup Scanner; Prompt. Advisory message. --- 

Scan Test; Prompt. Advisory message. --- 

Scan Operation;  Prompt. Advisory message. --- 

Laser; Prompt. Advisory message. ---

Contact/Pulse; Prompt. Advisory message. ---

Contact/No Pulse; Prompt. Advisory message. --- 
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Auto/Pulse; Prompt. Advisory message. ---

Auto/No Pulse; Prompt. Advisory message. --- 

Wand Simulation;  Prompt. Advisory message. --- 

VT100; Prompt. Advisory message. ---

VT220; Prompt. Advisory message. ---

SETUP; Prompt. Advisory message. ---

Mobile Unit IP/Radio; Prompt. Advisory message. --- 

Host List; Prompt. Advisory message. --- 

NULL; Prompt. Advisory message. ---
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